Inspiration® Quick Start Tutorial

This tutorial is a great starting point for learning how to use Inspiration. Please plan on about 45 minutes from start to finish.

If you’re new to Inspiration and like to learn while working on screen, this tutorial is for you. We have kept the information in small, manageable chunks to make it easy to learn the basics quickly. Before you know it, you’ll be using Inspiration to develop your own great ideas!

You use Inspiration the same way as most Mac OS and Windows programs. For example, as you work, you use the mouse to drag objects and to select text. You also click and double-click, as well as enter information using the keyboard. If you’re not comfortable doing these things, take a moment now and refer to the user’s guide that came with your computer.

Conventions we used

The tutorial has instructions for both Mac OS and Windows-based computers. When you’re asked to press a key or click a command on a menu, the Mac OS instructions appear first, and the Windows instructions are in parentheses immediately afterward. Here are two examples: Press Return (Enter) and press the Command (Ctrl) key.

When you’re asked to enter specific text, the text you will type appears in bold. For example, Career Thoughts. When referring to a symbol or name you already entered, it appears in italics, like Career Thoughts.

And a special note... Because people work in different ways, Inspiration offers many ways to do things—from toolbar buttons to menu commands to keyboard shortcuts. While these options are all readily available, this tutorial usually shows one way to do a task. By limiting the alternatives presented, we hope to make it easier to learn the task. In the Help system and the Inspiration User’s Manual, you will find many ways to do each task so you can pick the one that’s most comfortable for you. To access the Help system, see “Where to find more information” on page 1. To view or print the Inspiration User’s Manual, see “Viewing and printing Inspiration documentation” on page 14.
How we organized the tutorial

In the Inspiration tutorial, you follow a series of straightforward, step-by-step instructions to create a simple visual representation of an idea called a diagram. You also work with an outline – a text-based, hierarchical display of the same idea.

The tutorial is organized in mini-lessons. They’re designed to be completed in order, but you don’t need to do them all at one time. Each mini-lesson introduces you to several of the unique features in Inspiration. When you finish the tutorial, you will be ready to create diagrams and outlines on your own.
Mini-Lesson One: Getting Started

This tutorial models a student brainstorm about possible career choices.

In the first mini-lesson, you will learn the following:

• How to open Inspiration
• How to enter a main idea for your diagram
• How to use the Create tool to add symbols
• How to use the RapidFire® tool to add symbols
• How to use point and type to add an unconnected symbol
• How to replace a symbol with one from the Symbol palette
• How to use drag and drop to add a new symbol from the Symbol palette
• How to use the Link tool to link symbols
• How to add text on a link
• How to add a note to a symbol
• How to move a note
• How to move symbols
• How to change the colors of a symbol
• How to save an Inspiration document

Starting Inspiration

To start Inspiration on a Macintosh:

• Open the folder that contains Inspiration, and double-click the Inspiration icon.

  Inspiration opens a new, untitled diagram.

To start Inspiration in Windows:

• Click the Start button, point to Programs, and click Inspiration 7.6.
  Inspiration opens a new, untitled diagram.
Note: Before you can start the program, Inspiration needs to be installed. If you haven’t installed Inspiration on your computer yet, see “Installing Inspiration” on page 9.

Introducing Diagram View

Inspiration opens in Diagram View, where you process, organize and prioritize information visually. Key functions are right at your fingertips with the Diagram toolbar along the top, the Formatting toolbar at the bottom and the Symbol palette on the left.

Entering the main idea or topic

When you open Inspiration, a symbol appears in the center of the screen with the placeholder text, Main Idea, selected. It’s easy to get started—just enter a topic.
• Type the diagram topic, Career Thoughts, into the Main Idea symbol.

**Using the Create tool to add a new linked symbol**

There are many different ways to create new symbols in Diagram View. An easy way to add a linked symbol is to use the Create tool. The Create tool adds a new linked symbol in the direction you choose.

1. Select the Career Thoughts symbol. On the Diagram toolbar, position the cursor over the upper right point on the Create button.

   ![Click the upper right point to create a new linked symbol in that direction.](image)

   When you roll over a point on the Create button, it highlights to show the direction in which the new symbol will be created.

2. Click the upper right point. A new symbol appears connected to and diagonally above the Career Thoughts symbol. This symbol is selected and ready for you to enter an idea.

3. Type Enjoy my job into the new symbol.

**Trying it again**

Now use the Create tool again to add a second linked symbol.

1. Select the Career Thoughts symbol.

   This time, you’ll notice there’s a Subtopic Quick Control near the upper right corner of the symbol. The Subtopic Quick Control appears next to a symbol to show that it has a subtopic.

2. On the Diagram toolbar, position the cursor over the lower left point on the Create button.

   ![Click the lower left point to create a new linked symbol in that direction.](image)

3. Click the lower left point.
The new symbol appears connected to and diagonally below the Career Thoughts symbol.

4. Type Things I like to do into the new symbol.
5. Press Shift+Return (Shift+Enter) to end text entry and select the symbol.

Here’s what the diagram looks like now.

![Diagram](Image)

**Using the RapidFire tool to quickly capture ideas**

You’re going to use the RapidFire tool to brainstorm things you like to do. The RapidFire tool adds a series of linked ideas to a symbol. This allows you to concentrate on entering information, rather than creating symbols one at a time.

RapidFire places ideas in a freeform structure. There’s no need to think about organizing yet; you’re still getting ideas down to “see” what you think. You’ll learn more about organizing the information later in this tutorial.

1. Select the Things I like to do symbol, if it’s not already selected. On the Diagram toolbar, click the RapidFire button.

![RapidFire](Image)

The RapidFire icon appears in the symbol to show the tool is turned on.
2. Type **Fix things** and press Return (Enter).

3. Type **Tinker with cars** and press Return (Enter).

4. Type **Work in the garden**.

5. Click the RapidFire button again to turn the RapidFire tool off.

Here’s what the diagram looks like now.

*Tip:* If you made a mistake while entering text into a symbol, don’t worry. It’s easy to fix. Simply double-click the text in the symbol. Then select the words to change and type over them. You can also insert text by clicking where you want to make a correction and entering the new text.
Adding an unconnected symbol using point and type

Sometimes you want to add an idea, but you’re not exactly sure where it fits. You can easily add an unconnected idea to a diagram using point and type. Inspiration automatically creates a symbol to hold the text.

1. Click in the open area in the diagram directly to the right of the Career Thoughts symbol.
2. Type Not in an office.
   Inspiration automatically creates a symbol to hold the text. This symbol is not linked to any other symbol.
3. Click away from the Not in an office symbol to deselect it.

Replacing a symbol with one from the Symbol palette

Once you get some ideas down, it’s easy to replace a symbol already in the diagram with one from the Symbol palette. Inspiration offers over 1,300 colorful, high-resolution symbols, including several hundred photographic-quality images and animated symbols. The symbols are organized into categories and libraries.

1. Select the Tinker with cars symbol.
2. On the Symbol palette, click the Select Library button to navigate to the Everyday category. Choose the Transport 1 library.
3. Click the gray car.
   The Tinker with cars symbol automatically changes to the shape of this car.

Here’s what the diagram looks like now.
Inspiration® Quick Start Tutorial

Using drag and drop to add a specific symbol

You can also use drag and drop to add a symbol from the Symbol palette to represent a new idea. When you add a symbol using drag and drop the symbol is not connected to any other symbols.

1. On the Symbol palette, click the Select Library button to navigate to the Geography category. Select the Landforms library.

2. Drag the Mountains symbol until it’s positioned above the Work in the garden symbol and release the mouse button.
Now it’s time to add links. Links show the connections and relationships between ideas.

1. Select the *Career Thoughts* symbol. This is the symbol where the link will start.

2. On the Diagram toolbar, click the Link button to turn on the Link tool.

The cursor now looks like this 🖼️.

**Linking symbols**

Now it’s time to add links. Links show the connections and relationships between ideas.

1. Select the *Career Thoughts* symbol. This is the symbol where the link will start.

2. On the Diagram toolbar, click the Link button to turn on the Link tool.

The cursor now looks like this 🖼️.
3. Click the *Not in an office* symbol. This is the symbol where the link will end.
   A link with the arrowhead pointing to the *Not in the office* symbol appears.

4. Click the *Career Thoughts* symbol again.

5. Now click the *Mountains* symbol.
   A second link appears and the arrowhead points to the *Mountains* symbol.

6. Click the Link button again to turn off the Link tool.

Here's what the diagram looks like now.
**Adding text on the link**

Each link has a text box that appears when the link is selected. Adding text to this box defines the relationship between the symbols.

1. Select the link between the *Career Thoughts* symbol and the *Mountains* symbol, if it’s not already selected.
   
   When a link is selected, you see the outline of the text box associated with that link. It’s ready for you to begin typing.

2. Type **out of the city**. Click off the link to deselect it.

Here’s what this section of the diagram looks like now.

![Diagram with text box showing "out of the city"](image)

**Adding a note to a symbol**

For each symbol in a diagram a note is available. Notes allow you to expand ideas and actually begin the writing process, while continuing to work in the visual format.

1. Select the *Mountains* symbol. On the Diagram toolbar, click the Note button.

![Note button](image)

A note opens below the symbol.

2. Type **I’d like to live here**. into the note.
Moving a note

Because people work in different ways, notes are flexible. After you add a note to a symbol, it’s easy to move the note to another location on the symbol, or to any open place in the diagram.

1. Select the open note.
2. Click the note title bar and drag the note so that it touches the right side of the Mountains symbol.

Here’s what the diagram looks like now.
I'd like to live here.

out of the city

Enjoy my job

Work in the garden

Career Thoughts

Not in an office

Things I like to do

Fix things

Tinker with cars
Moving symbols

You can also move a symbol to another location in the diagram.

1. Select the Work in the garden symbol.
2. Drag the symbol so it is directly below Things I like to do and between the Tinker with cars and Fix things symbols. Release the mouse button.

Inspiration keeps the link attached so you never lose the connection between ideas when you rearrange the diagram.

Here’s what the diagram looks like now.
Changing the color of symbols

Color is great for customizing the look of symbols. It helps distinguish items in a diagram and is often used to identify a group of related ideas.

1. With the Work in the garden symbol still selected, also select the Things I like to do and Fix things symbols.
   To select more than one item, press the Shift key and click each item, or click and hold down the mouse to drag a selection box around the symbols.

2. On the Formatting toolbar, click the Fill Color button and choose a color from the palette.

   ![Select the symbol, and then click the Fill Color button to choose a new color.](image)

   When you change the fill color of a symbol the color inside the symbol changes.
   Select a light color, such as light purple. This lets the text continue to show up nicely against the symbol’s fill color.

3. Click off the symbols to deselect them.

Changing the colors in a multicolor symbol

Changing the colors in a multicolor symbol allows you to further customize your work. You can change the colors in any multicolor symbol in the symbol libraries.

1. Select the Tinker with cars symbol. On the Formatting toolbar, the existing colors in the symbol appear in order of most frequently occurring to least frequently occurring.

2. Click the first color, light gray, and select a new color from the palette that matches the look of the other Things I like to do subtopics. This color will replace the light gray color that appears in the Tinker with cars symbol.

Saving your work

Whenever you’re working on a document, it’s a good idea to save it on a regular basis. To save a document for the first time, or to save a document you’ve already saved before under the current name, use the Save command.
1. On the File menu, choose Save. The dialog box appears with the main idea as the name of the file.

2. If necessary, navigate to the folder in which you want to save the diagram.

3. Click Save.
   In Windows, the file is saved with a .isf extension.

**Quitting Inspiration**

If you’re ready to take a break from the tutorial, you can quit Inspiration after saving your changes. If you want to continue, just skip this procedure and turn to the next mini-lesson.

1. To close your file and quit Inspiration, on the File menu, choose Quit (Exit). If you’ve made changes to the document, Inspiration asks if want to save those changes.

2. Click Yes to save your changes and quit Inspiration. You can start again with the next mini-lesson.
Mini-lesson Two: Outline View

Inspiration’s diagramming and outlining environments are fully integrated. While you’ve been creating a visual map of your ideas in Diagram View, Inspiration has also been working behind the scenes, building an outline of your work.

In this second mini-lesson, you open the diagram created in the previous lesson and work with it in Outline View. You will learn the following:

- How to switch to Outline View
- How to add a topic
- How to add a subtopic
- How to move a topic by dragging
- How to change the level of a topic
- How to hide and show subtopics and notes
- How to add notes text
- How to change topic defaults
- How to change topic prefixes
- How to print an outline

Tip: If you quit Inspiration, you need to start the program and open the Career Thoughts document.

Switching from Diagram View to Outline View

When you switch to Outline View, your information is structured in a conventional hierarchy.

1. Select the Career Thoughts symbol.
2. To view a diagram in Outline View, click the Outline button on the Diagram toolbar.

The diagram is transformed into an outline. The symbols now appear as topics and subtopics, and the notes text is visible. Even though you did not name the Mountains symbol in Diagram View, the Picture-to-Topic option automatically provided a label for the topic to ensure you did not lose the relationships between ideas when you switched views.
Here’s what your outline looks like now.

I. Enjoy my job
   A. Fix things
   B. Timber with cats
   C. Work in the garden

II. Things I like to do

III. Not in an office

IV. Mountains
   I’d like to live here.
Adding a topic

You can add a new topic in Outline View as easily as you added a new symbol in Diagram View.

1. If it’s not already selected, select the Career Thoughts topic by clicking in the Selection control column. A selection box appears around the topic to show it’s selected.
2. On the Outline toolbar, click the Topic button.

Inspiration inserts a new topic and automatically assigns it a prefix. The cursor moves to the new line so you’re ready to enter text for your new idea.

3. Type Work outside.

Adding a subtopic

It’s also easy to add new subtopics. These ideas provide information subordinate to or supplemental to a topic.

1. With Work outside selected, click the Subtopic button on the Outline toolbar.

When you add a subtopic to a topic, Inspiration automatically indents it one level below the selected topic and assigns it a prefix. The cursor also moves to the new line so you can enter text for the new idea.

2. Type Maybe in a national forest.

Here’s what this section of the outline looks like now.
**Moving a topic by dragging**

There are many ways to organize your outline. One of the easiest is simply dragging a topic (and its subtopics) up or down in the outline.

1. Select the *Not in an office* topic.
2. Drag the topic so it is positioned directly below the *Maybe in a national forest* subtopic. Release the mouse button.

While you drag, the topic remains in its original position until you release the mouse button. You can tell where the topic’s new location will be by watching the black line as you drag. The small arrow on the line indicates the level of the topic’s new location.

The *Not in an office* topic now appears as a subtopic of *Work outside*, at the same level as the *Maybe in a national forest* subtopic.

Here’s what the outline looks like now.

```
Career Thoughts

I. Work outside
   A. Maybe in a national forest
   B. Not in an office

II. Enjoy my job

III. Things I like to do
   A. Fix things
   B. Tinker with cars
   C. Work in the garden

IV. Mountains
   I’d like to live here.
```

**Changing the level of a topic**

If you decide a topic belongs at a lower level in the outline, it’s easy to move it down in the hierarchy.

1. Select the *Tinker with cars* topic.
2. On the Outline toolbar, click the Right button.
The *Tinker with cars* topic moves to the right and is now a subtopic of *Fix things*.

Here’s what this section of the outline looks like now.

![Outline](image)

**Hiding subtopics**

To make it easier to organize an outline, it’s often useful to hide subtopics so you can concentrate on the main topics.

1. Click the Subtopic Quick Control ▼ to the left of the *Things I like to do* topic. The subtopics for this topic are now hidden.
2. Click the Subtopic Quick Control again to show the subtopics.
Adding notes text to a topic

Notes text is a good way to further develop ideas in Outline View. You can add anything from one sentence to several pages of text.

1. Select the *Work in the garden* topic.
2. On the Outline toolbar, click the Note button.

![Note button]

The cursor moves to a new line so you can enter the notes text.

3. Type *I've done some great plant experiments*.

When you add a note, a Note Quick Control appears in the Note control column to the left of the topic.

Hiding and showing notes text

Just as you can hide and show subtopics, you can hide and show notes text.

1. With the *Work in the garden* topic selected, click the Note Quick Control to hide the notes text.
   
   The status of the Note Quick Control changes to show that the note is now hidden.

2. Click the Note Quick Control again to show the note.

Setting topic defaults

You can set the defaults for any or all topic levels and notes. The default options include font, text size, text color and other style choices.

1. Select the *Career Thoughts* topic. On the Formatting toolbar, click the Topic Defaults button.

   The Topic Defaults dialog box appears.

2. Select Level 1 and change the color to bright blue. Click Preview.

3. Change the font to Helvetica. Click OK.

Here's what the outline looks like now.
### Career Thoughts

<table>
<thead>
<tr>
<th>▼</th>
<th><strong>I. Work outside</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A. <strong>Maybe in a national forest</strong></td>
</tr>
<tr>
<td></td>
<td>B. <strong>Not in an office</strong></td>
</tr>
<tr>
<td>▼</td>
<td><strong>II. Enjoy my job</strong></td>
</tr>
<tr>
<td>▼</td>
<td><strong>III. Things I like to do</strong></td>
</tr>
<tr>
<td></td>
<td>A. <strong>Fix things</strong></td>
</tr>
<tr>
<td></td>
<td>1. <strong>Tinker with cars</strong></td>
</tr>
<tr>
<td></td>
<td>B. <strong>Work in the garden</strong></td>
</tr>
<tr>
<td></td>
<td>I've done some great plant experiments.</td>
</tr>
<tr>
<td>▼</td>
<td><strong>IV. Mountains</strong></td>
</tr>
<tr>
<td></td>
<td>I'd like to live here.</td>
</tr>
</tbody>
</table>

### Changing topic prefixes

You can also change outline prefixes. There are a variety of prefix styles available.

1. On the Formatting toolbar, click the Prefix button 🔄.
2. Select a new prefix style.
   
   All of the prefixes in the outline are changed to reflect your selection.
**Printing the outline**

Before you print the outline, you can determine layout, margins, headers and footers, etc., by selecting Page Setup on the File menu. Page Setup also allows you to preview the outline before printing and, once you’re ready, to print the outline.

2. Make your selections and choose Print Preview to preview your work.
3. Click Print to print your outline.

**Taking a break**

If you’re ready to take a break from the tutorial, save your changes and quit Inspiration. If you want to continue, just skip this procedure and turn to the next mini-lesson.
Mini-lesson Three: Returning to Diagram View

Since the Inspiration views are fully integrated, when you return to Diagram View you’ll find the diagram has changed to reflect the work done in Outline View.

In this final mini-lesson, you return to Diagram View and complete the Career Thoughts diagram as you learn each of these procedures:

- How to switch to Diagram View
- How to automatically arrange a diagram
- How to change the view scale
- How to position a diagram in the window
- How to change symbol defaults
- How to change the colors of a note
- How to add a hyperlink
- How to record a sound
- How to print a diagram
- How to transfer your work to a word processor
- How to export a diagram

Tip: If you quit Inspiration, you need to start the program and open your Career Thoughts document.

Switching from Outline View to Diagram View

1. Select the Career Thoughts topic, if it’s not already selected.
2. On the Outline toolbar, click the Diagram button.

The outline is transformed into a diagram.

Here’s what the diagram looks like now, including the work done in Outline View.
Arranging the diagram

The Arrange tool arranges a diagram into various formats.
1. On the Diagram toolbar, click the Arrange button.
The Arrange dialog box appears.

2. In the Links list, choose Standard.
3. In the Diagram Type list, choose Top Down Tree.
4. Click OK.

The diagram automatically rearranges in the new format.

Here's what it looks like now.

---

**Changing the view scale**

Magnifying and reducing the view allows you to work with specific parts of your diagram or outline, or to see the entire screen at one time. To see more of a diagram or outline in the window, you zoom out. To make symbols or topics look bigger, you zoom in. You can also zoom in or out to a specific percentage.

1. On the Scroll bar, click the Zoom In button \(\text{TikTok}^1\) one time. This makes the diagram appear larger on the screen.
2. If you'd like the diagram to appear smaller on the screen, click the Zoom Out button \(\text{TikTok}^2\).
Positioning the diagram in the window

To work with a specific section of your diagram you can also move the diagram around within the window.

1. On the Formatting toolbar, click the Position button.
2. Click and drag the diagram in the direction you want.
   You can click and drag as many times as you need until the diagram is where you want it in the window.
3. Click the Position button again to turn the Position tool off.

Changing symbol defaults

Changing the defaults for symbols allows you to easily create multiple symbols with the same characteristics.

1. Select the Work outside symbol.
2. On the Formatting toolbar, click the Fill Color button. Select a light blue color from the palette.

   ![Click the Fill Color button to choose a color.]

   The color inside the symbol changes to reflect your selection.

3. With the Work outside symbol still selected, click the Line Color button. Select a dark red color from the palette.

   ![Click the Line Color button to choose a color.]

   The color of the line around the symbol changes to dark red.

4. On the Formatting toolbar, click the Defaults button. Choose Set Default.
5. Now select the Not in an office and Maybe in a national forest symbols.
   To select more than one item, press the Shift key and click each item. Or, click and hold down the mouse to drag a selection box around the symbols.
6. Click the Defaults button [12], and then choose Apply Default. These symbols now exhibit the same formatting as the *Work outside* symbol.

**Changing the color of a note**

Note colors are also changeable so you can customize them to match the symbols.

1. Select the *Work in the garden* symbol. Click the Note Quick Control [8].

   The note opens.

2. On the Formatting toolbar, click the Fill Color button and choose a light purple color from the palette. This will change the color inside the note.

   ![Click the Fill Color button to choose a color.]

3. Then click the Line Color button and select a slightly darker purple color from the palette to change the color of the line around the note. Now the note matches this group of symbols.

   ![Click the Line Color button to choose a color.]

**Adding a hyperlink**

You can further enhance a project by integrating resources from the Internet. You can also hyperlink to a document created with Inspiration or another application.

1. Select the words “national forest” in the *Maybe in a national forest* symbol.

2. On the Diagram toolbar, click the Hyperlink button.

   ![Hyperlink]

   The Hyperlink dialog box appears.
   The selected text appears in the Hyperlink Text box.
4. In the Link To box, type http://www.fs.fed.us/. Click OK.
   This creates a hyperlink to the USDA Forest Service web page.
5. Click off the symbol to deselect it.

Here's what the diagram looks like now.
**Recording a sound**

You can annotate diagrams and outlines with recorded comments.

To record sounds, Record Sounds must be made available in Application Properties, and your computer must have a microphone. You will find Application Properties on the Utility menu.

1. Select the *Enjoy my job* symbol.
2. On the Tools menu, point to Sound, and then click Record.
3. In the recording control box, click Record to begin recording.
4. Say *It’s important that I have balance in my life.*
5. When you finish recording, click Save.

The Audio Quick Control 🎧 is now displayed next to the *Enjoy my job* symbol. Click the Audio Quick Control to play your recorded sound.
Taking a final look

Congratulations! You’ve finished creating your Career Thoughts project. Here’s one more look at how the diagram appears on the screen.
Printing the diagram

When you print from Diagram View, the default is Fit to 1 Page, which automatically sizes the diagram to fit on one page. If desired, this can be adjusted so the diagram prints full size on multiple pages.

   Here you set up the diagram layout, determine margins, headers and footers, and preview your diagram before printing.
2. Make your selections, and then choose Print Preview to preview your work.
3. Click Print to print your diagram.

Transferring to a word processor

When you are ready to finalize your work for publication, you can easily transfer it to a word processor.

• Click the Transfer button on the toolbar.

Inspiration automatically launches your preferred word processor (Microsoft Word or Appleworks) and transfers your work.

The new document retains the look and structure of your Inspiration outline. When transferring from the Diagram View, a picture of the diagram also appears.

Exporting the diagram

Once you create a diagram or an outline, you can export it for use in a variety of other programs.

• On the File menu, choose Export and make your selections.

You can also save diagrams as HTML files (also called web pages) that can be viewed using a web browser such as Netscape Navigator or Microsoft Internet Explorer. Options include a single web page or even building an entire web site using the Site Skeleton export. To export your diagram as an HTML file, on the File menu, choose Export as HTML and make your selections.

Congratulations! You’re now ready to use the power of visual learning to develop all your great ideas.